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1. INTRODUCCIÓN A SAGA GIS 
 
1.1 SISTEMAS DE INFORMACIÓN GEOGRÁFICA (SIG) 

 
Un SIG es una herramienta que permite visualizar, almacenar, comparar y analizar de forma 
eficiente información geográficamente referenciada de diferente naturaleza. 

 
Cuando nos referimos a información geográficamente referenciada, o georreferenciada, nos 
referimos a que los datos incluyen su posición sobre la superficie terrestre, es decir, sus 
coordenadas. 

 
Un SIG permite integrar y analizar información de diferente naturaleza, como información 
geográfica (altitud, ríos, cuencas hidrográficas, etc.), administrativa (límites de países, provincias, 
municipios, etc.) o ambiental (datos de estaciones climatológicas, salidas de modelos numéricos 
meteorológicos, caudales de ríos, cubierta vegetal, etc.) 

 
Esta posibilidad que ofrecen los SIG de integrar, combinar y trabajar de forma eficiente con datos 
georreferenciados procedentes de diferentes ámbitos es la que proporciona a los SIG una gran 
versatilidad y potencia para su uso en múltiples campos de estudio. 
 
La información geográfica con la que trabajaremos en un SIG va a estar organizada en capas, 
siendo cada capa una modelización de una característica concreta de la realidad en la zona de 
estudio considerada. 
 
 

 
 

Ejemplo de información organizada en capas 

 
Una capa puede estar formada por uno o varios archivos que contendrán la información sobre 
las coordenadas de los elementos de la capa, los valores de la variable modelizada y su 
representación gráfica. 
 
Existen dos enfoques fundamentales a la hora de modelizar una característica de la realidad para 
generar una capa: ráster y vectorial. 
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En el modelo ráster se divide de forma sistemática todo el espacio de la zona de estudio en una 
malla de celdas regulares y se asigna a cada celda un valor numérico que representa la 
característica analizada.  
 
 

 
 

Ejemplo de capa ráster (altitud) 

 

Existen muchos formatos de capas ráster: GeoTIFF,  SGRD, GRD, Esri Grid, etc. Desde hace 
algunos años, el formato GeoTIFF es el formato estándar OGC para el intercambio de datos 
ráster.  
 
Una capa GeoTIFF está formada por un único archivo de extensión .tiff 
 

En el modelo vectorial, cada capa de información está formada por un conjunto de elementos 
discretos homogéneos de uno de estos tres tipos: puntos, líneas o polígonos. A cada elemento 
se le asigna una o varias propiedades alfanuméricas, denominadas atributos.  

 

 
 

Ejemplo de capa vectorial de puntos (estaciones automáticas de AEMET)  

 
 

 
 

Ejemplo de capa vectorial de líneas (ríos de la Base Topográfica Nacional BTN 100 del IGN)  
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Ejemplo de capa vectorial de polígonos (CCAA de la Base Topográfica Nacional BTN 100 del 

IGN) 
 
Aunque existen diversos formatos de capas vectoriales, prácticamente todos los SIG utilizan el 
formato shape, pudiendo considerarse de facto un formato estándar.  
 
Una capa shape está formada por al menos tres archivos: 
 *.shp → Almacena las entidades geométricas de los objetos. 

*.shx → Contiene el índice de las entidades geométricas, el cual permite buscar a través 
de ellas de forma rápida. 

 *.dbf → Es la tabla de datos con los atributos de la capa. 
 
Puede contener además otros archivos opcionales, como un archivo *.prj con el sistema de 
referencia de coordenadas de la capa.  
 

En principio, cualquier característica de la realidad puede modelizarse como una capa vectorial 
o como una capa ráster. 

 

 
Altitud del terreno en modelo ráster y en modelo vectorial (líneas), en el que se han 

representado las isolíneas de altitud a intervalos de 100m. 
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Representación de las cuencas hidrográficas principales, ríos y localización de estaciones 

meteorológicas en el sureste de la península ibérica mediante modelos vectorial y ráster. 

 

No obstante, resulta evidente que: 

 El modelo vectorial es más adecuado para representar características asimilables a 

figuras geométricas u objetos, como ríos, municipios, carreteras, etc., siendo mucho 

más eficiente que el modelo ráster para la representación de objetos.  

 El modelo ráster es más adecuado para representar variables numéricas que varían 

de forma continua en el espacio, como la altitud del terreno, la temperatura del aire, la 

precipitación,  etc., y para realizar operaciones de análisis espacial con ellas. 

 

Del análisis anterior se desprende que lo ideal es trabajar simultáneamente con ambos tipos 

de modelos, ráster y vectorial, en un mismo SIG, de forma que podamos representar cada 

variable en el modelo más adecuado.  

 

Actualmente, prácticamente todos los SIG son híbridos (permiten trabajar con capas ráster y 

vectoriales), si bien suelen estar especializados en el manejo de uno de los dos tipos de modelos 

de datos: ráster o vectorial. 

 

  

1.2 SAGA GIS 
 

SAGA GIS es un SIG libre y gratuito que comenzó a desarrollarse en 2001 en la Universidad 
de Göttingen (Alemania). 
 
Objetivo: proporcionar una herramienta potente y a la vez sencilla de aprender y manejar para 
la implementación de métodos geo-científicos → orientada al mundo científico y académico: 
universidades, organismos públicos de investigación, etc. 
 
Escrito en el lenguaje de programación C++. 
 
Existen versiones para Windows y para Linux. 
 
SAGA GIS es un SIG híbrido, especialmente potente en aplicaciones ráster. 
 
SAGA tiene una arquitectura modular: cada módulo es un pequeño programa independiente que 
permite ejecutar una herramienta determinada. Los módulos se encuentran agrupados en 
librerías. 
 
En la versión 9.2.0 hay 92 librerías que contienen 824 módulos, lo que da una idea de su 
enorme potencia para el análisis espacial. 
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Formatos propios de SAGA GIS:  

 GeoTIFF y SGRD para capas ráster 

 SHP para capas vectoriales 
 

Los proyectos de SAGA GIS son archivos con formato .sprj 

Página web: http://www.saga-gis.org 

 

1.3 INSTALACIÓN DE SAGA GIS 

 
Desde la página oficial de SAGA http://www.saga-gis.org accedemos a la sección de descargas 
(Downloads), donde se encuentran las diferentes versiones para Windows y Linux publicadas 
hasta el momento, así como los manuales y los datos y capas necesarios para seguir los 
ejemplos de los manuales. 
 
Para Windows, tenemos la posibilidad de instalar la versión ejecutable descargando el archivo 
saga-9.2.0_x64_setup.exe, o bien descargar la versión comprimida saga-9.2.0_x64.zip, que 
no necesita permiso de administrador. En este último caso, basta con descomprimir el archivo y 
ejecutar el archivo saga_gui.exe que se encontrará en la carpeta donde hayamos 
descomprimido el archivo zip. 
 
 
 
1.4 MANEJO BÁSICO DE SAGA GIS 
 
Practicar realizando el siguiente ejercicio. 
 
EJERCICIO 1: Representar en un mapa las capas siguientes: 

 chirps-v2.0.2021.tif   Precipitación acumulada anual en 2021 en mm (CHIRPS 2.0) 

 CNTR_RG_01M_2020_4326.shp    Límites de países del mundo (EUROSTAT) 

 ciudades_Mundo.shp  Ciudades del mundo    
Emplear la tabla de color Tabla_color_Panual.txt para representar la capa de precipitación.  
 

 
 

2. INFORMACIÓN GEOGRÁFICA GEORREFERENCIADA 
 

 
2.1 MODELOS DIGITALES DE ELEVACIONES (DEM)  

  
 

GTOPO30: https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-
global-30-arc-second-elevation-gtopo30 
Modelo digital de elevaciones global con un espaciado horizontal de rejilla de 30 segundos de 
arco (= 0.00833 º, aprox. 1 km). 
Derivado a partir de distintas fuentes, completado en 1996. 
Proyecto colaborativo liderado por el USGS. 
Enlace descarga GTOPO30 (sin registrarse): http://www.webgis.com/terr_world.html 
Enlace descarga desde NCAR: https://rda.ucar.edu/datasets/ds758.0/ 
 

https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-global-30-arc-second-elevation-gtopo30
https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-global-30-arc-second-elevation-gtopo30
http://www.webgis.com/terr_world.html
https://rda.ucar.edu/datasets/ds758.0/
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Otros modelos digitales de elevaciones: 
 

STRM3: https://srtm.csi.cgiar.org/ 
Modelo digital de elevaciones casi global (80% del territorio) con una resolución de 3 segundos 
de arco (90 m en el ecuador). 
Generado por la NASA. 

 
 

2.1 CAPAS SHAPE CON LÍMITES ADMINISTRATIVOS 
 

EUROSTAT: https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-
units-statistical-units/countries 

 
Capas shape de alta resolución (1:1000000) con fronteras de los países, líneas de costa y 
capitales de estado en diferentes sistemas de referencia de coordenadas. 

 
 

https://srtm.csi.cgiar.org/
https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-units/countries
https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-units/countries
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EJERCICIO 2: Descargar el modelo digital de elevaciones GTOPO30 necesario para crear un 
DEM de Colombia y recortarlo usando la capa shape de polígonos 
CNTR_RG_01M_2020_4326.shp correspondiente a las fronteras de los países de EUROSTAT 
a escala 1:1000000  

 
Descargar el modelo W100N40  

 
Importar el DEM con la herramienta Import Raster (en las últimas versiones de SAGA GIS ya 
no es necesario importar los archivos DEM, se pueden abrir directamente)  

Herramienta: Import Raster 
Librería: io_gdal 
Menú: Geoprocessing > File > Grid 
 

 
 
 

Añadir la capa CNTR_RG_01M_2020_4326.shp con las fronteras de los países. 
 
Crear una capa shape con el polígono correspondiente a Colombia seleccionando el polígono y 
utilizando a continuación la herramienta Copy Selection to New Shapes Layer 

Herramienta: Copy Selection to New Shapes Layer 
Librería: shapes_tools 
Menú: Geoprocessing > Shapes > Selection 
 

 
 
 

Recortar el DEM a los límites de Colombia con la herramienta Clip Grid with Polygon,  
Herramienta: Clip Grid with Polygon 
Librería: shapes_grid 
Menú: Geoprocessing > Shapes > Shapes-Grid Tools > Spatial Extent 
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Representar el MDE usando la tabla de colores Tabla_Altitud.dbf  
 
NOTA: En el caso de trabajar un país que abarque más de una cuadrícula del GTOPO30, 
descargaríamos los DEM correspondientes y los uniríamos con la herramienta Mosaicking 

Herramienta: Mosaicking 
Librería: grid_tools 
Menú: Geoprocessing > Grid > Grid System 

 

 
 
 
 

3 DATOS CLIMÁTICOS  
 
 

3.1 DATOS NORMALES CLIMATOLÓGICOS 
 

NOAA: https://www.ncei.noaa.gov/products/wmo-climate-normals 
 

Normales estándar climatológicas de diferentes periodos de referencia de países de todo el 
mundo. 

 
 

EJERCICIO 3: Descargar los valores normales estándar climatológicos 1961-1990 de 
temperatura mensual y anual de Colombia y representarlos como capa shape junto con el 
modelo digital de elevaciones y el resto de capas preparadas en el ejercicio anterior.  

https://www.ncei.noaa.gov/products/wmo-climate-normals


9 

 

 
Para convertir una tabla de datos en una capa shape de puntos, utilizar la herramienta Convert 
Table to Points 
 

Herramienta: Convert Table to Points 
Librería: shapes_points 
Menú: Geoprocessing > Shapes > Conversion 

 
 

 
 

 

 

3.2 DATOS CLIMÁTICOS 
 

NOAA: https://www.ncdc.noaa.gov/cdo-web/search 
Búsqueda online de datos climáticos de todo el mundo. 
 
Global Historical Climatology Network monthly (GHCNm): 
https://www.ncei.noaa.gov/products/land-based-station/global-historical-climatology-network-
monthly 
 

 

 

 

4 INTERPOLACIÓN ESPACIAL DE DATOS CLIMÁTICOS  
 
 

Entre los métodos habitualmente empleados para interpolar espacialmente datos climáticos se 
encuentran los siguientes: 
 
 
4.1 INVERSA DE LA DISTANCIA (IDW) 
 
+ Sencillo de aplicar 
+ Robusto, poco sensible a datos anómalos 
- Tiende a crear círculos (bull’s-eyes) alrededor de los máximos y de los mínimos  
 

Herramienta: Inverse Distance Weighted 
Librería: grid_gridding 
Menú: Geoprocessing > Grid > Gridding > Interpolation 

 

https://www.ncei.noaa.gov/products/land-based-station/global-historical-climatology-network-monthly
https://www.ncei.noaa.gov/products/land-based-station/global-historical-climatology-network-monthly


10 

 

 
 

 

4.2 MULTILEVEL B-SPLINE (MBS) 
 

+ Sencillo de aplicar 
+ Proporciona superficies suaves, de agradable aspecto 
- Tiende a extrapolar las tendencias, muy sensible a datos anómalos o a variaciones bruscas 
de la variable 
 

Herramienta: Multilevel B-Spline 
Librería: grid_spline 
Menú: Geoprocessing > Grid > Gridding > Spline Interpolation 

 

 

 
 

 

4.3 KRIGEADO ORDINARIO (KO) 
 

+ Buenos resultados con la mayoría de las variables climáticas 
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+ Proporciona superficies suaves, de agradable aspecto 
- Método complejo, necesario hacer un ajuste del variograma, si no se aplica adecuadamente 
puede dar lugar a interpolaciones defectuosas 
 

Herramienta: Ordinary Kriging 
Librería: statistics_kriging 
Menú: Geoprocessing > Spatial and Geostatistics > Kriging 

 

 
 

 

EJERCICIO 4: Interpolar espacialmente la temperatura anual media 1961-1990 de Colombia 
utilizando los tres métodos vistos hasta ahora (IDW, MBS y KO) y comparar los resultados. 
 

 

4.4 REGRESIÓN CON INTERPOLACIÓN DE LOS RESIDUOS 
 

+ Buenos resultados si existe correlación entre la variable climática y la variable o variables 
auxiliares (p.ej., temperatura y altitud en muchos casos) 
- No funciona bien con todas las variables climáticas, puede dar lugar a interpolaciones sin 
sentido físico 
 

Herramienta: Multiple Regression Analysis (Points and Predictor Grids) 
Librería: statistics_regression 
Menú: Geoprocessing > Spatial and Geostatistics > Regression 
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EJERCICIO 5: Interpolar espacialmente la temperatura anual media 1961-1990 de Colombia 
utilizando el método de regresión con la altitud con interpolación de los residuos por MBS y 
comparar el resultado con el obtenido en el ejercicio anterior. 
 
EJERCICIO 6: Interpolar espacialmente la precipitación acumulada anual media 1961-1990 de 
Colombia utilizando los métodos vistos hasta ahora: IDW, MBS, KO y regresión con la altitud 
con interpolación de los residuos. ¿Es posible aplicar el modelo de regresión con la altitud en 
este caso? 
 
 
 

5 OBTENCIÓN DE REJILLAS CLIMÁTICAS A PARTIR DE 
REANÁLISIS DE MODELOS NUMÉRICOS  
 
 

ERA5-Land monthly averaged data from 1950 to present: 
https://cds.climate.copernicus.eu/cdsapp#!/dataset/reanalysis-era5-land-monthly-
means?tab=overview 
 
Es necesario registrarse para poder descargar las rejillas. 
 
Conjunto de datos de reanálisis desde 1950, con un tamaño de celda de 0.1° x 0.1° (aprox. 11 
km) 
 
Unidades: Temperatura en Kelvin 
  Precipitación en M/día 
 
 
EJERCICIO 7: Obtener la rejilla de temperatura mensual media de mayo de 2022 de Colombia 
a partir del reanálisis ERA5-Land de dicho periodo. 
 
Utilizar la herramienta Import Raster para importar la rejilla con la temperatura media de mayo 
de 2022 de ERA5-Land: 
 

Herramienta: Import Raster 

https://cds.climate.copernicus.eu/cdsapp#!/dataset/reanalysis-era5-land-monthly-means?tab=overview
https://cds.climate.copernicus.eu/cdsapp#!/dataset/reanalysis-era5-land-monthly-means?tab=overview
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Librería: io_gdal 
Menú: Geoprocessing > File > Grid 
 

 
 

 
Pasar de K a ºC con la herramienta 
 

Herramienta: Grid Calculator 
Librería: grid_calculus 
Menú: Geoprocessing > Grid > Calculus 

 
 

 
 

 
EJERCICIO 8: Obtener la rejilla de temperatura anual media 1961-1990 de Colombia a partir 
de las rejillas de temperatura media mensual de ERA5-Land de dicho periodo. Comparar los 
resultados con los obtenidos en el ejercicio 5.  
 
Utilizar la herramienta Import Raster para importar el conjunto de rejillas mensuales 1961-1990 
 

Herramienta: Import Raster 
Librería: io_gdal 
Menú: Geoprocessing > File > Grid 
 

Es necesario elegir la opción single grids en el campo Multiple Bands Output 
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Utilizar la herramienta Grids Sum para sumar las rejillas de temperatura mensuales 
 

Herramienta: Grids Sum 
Librería: grid_calculus 
Menú: Geoprocessing > Grid > Calculus 

 
 

 
 
Y obtener el campo de temperatura media anual 1961-1990 con la herramienta Grid Calculator, 
dividiendo la suma de los campos de temperatura por 360, el número de meses que hay en el 
periodo, y restar 273.15 para pasar a ºC 
 

Herramienta: Grid Calculator 
Librería: grid_calculus 
Menú: Geoprocessing > Grid > Calculus 
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EJERCICIO 9: Comparar los datos de precipitación acumulada anual media 1961-1990 de 
Colombia con la precipitación anual media del mismo periodo de ERA5-Land.  
 

 
 
 
 

6 OBTENCIÓN DE REJILLAS DE PRECIPITACIÓN A PARTIR 
DE CHIRPS  
 
 

CHIRPS: Datos en rejilla desde 1981 con una resolución de 0.05° x 0.05° (aprox. 6 km) para la 
mayor parte del globo (50°S-50°N). Incorpora imágenes de satélite de 0.05° de resolución con 
datos de estaciones para crear rejillas de precipitación para análisis de tendencias y 
monitorización de las sequías: https://www.chc.ucsb.edu/data/chirps 
 
EJERCICIO 10: Comparar los datos de precipitación acumulada anual media 1961-1990 de 
Colombia con la precipitación anual media 1981-2021 de CHIRPS.  

https://www.chc.ucsb.edu/data/chirps

